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INTRODUCTION 

Access is a database program, created by Microsoft.  The Trust has now started to 
use Access 2000 in the Windows NT operating system (which has replaced Access 
2.0 running in Windows 3.1). 

What Is A Database? 
Databases are used to store information in a structured way. 

Computerised databases enable you to store large amounts of information.  You can 
then search for any piece of information or sort the information by any criteria.  You 
can cross reference the data easily, and extract data to be viewed on screen or 
printed out in a variety of different formats. 

For example, if you have a database of staff working at a company, you can extract 
the names of all staff who work at a certain location and have been with the company 
for over 5 years.  You can then sort the extracted list alphabetically by surname and 
print it out. 

Multiple Users 
Unlike Word documents and Excel spreadsheets, an Access database can be used by 
several people at the same time.  The changes made by all the users will be saved 
into the same database.  This avoids the need to duplicate data as you can create one 
single database that everyone can access at any time. 

This Manual 
This Basic manual is aimed at people needing to use an existing Access 2000 
database.  If you need to create a new database, you should read this manual and 
then read the Intermediate manual. 

This manual assumes a knowledge of Windows NT.  A familiarity with Excel will also 
be useful. 

All the pictures in this manual are based on a demonstration Access 2000 database 
called Staff2000.  you can request a copy of the database from the IT Training team. 

All the important instructions in this manual appear in bold.  Toolbar button and Menu 
commands appear bold and in quotation marks.  Keyboard instructions are bold and in 
square brackets.  For example: In the "Edit" menu, select "Undo", or use the 
combination command [Ctrl]+[Z]. 
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NEW FEATURES IN ACCESS 2000 

If you are upgrading from Access 2.0, you will find that Access 2000 looks slightly 
different to begin with, but works in the same way.  

These are some of the basic new features in Access 2000. 

Feature Description of Change 
Toolbars Toolbar buttons are now flatter.  

 
Menus In an attempt to simplify the drop down menus, less 

popular commands do not initially appear in each menu.  
But you can click on the arrow at the bottom of the menu to 
view all the available commands. 

 
Database Window The Database Window has been reformatted. 

There is also a new database object, called a Page. 

 

Drop Down Lists in 
Tables 

This is a useful new feature.  You can now create a drop 
down list in a table to allow users to input values by 
selecting them in the list.  (Previously you could only do 
this on a form). 

 

Sorting The sort order of records is now saved when you save the 
layout of a table (so that the records will appear in the 
saved order when you next open the table). 

Two Digit Year Dates Access 2000 recognises two digit dates between the 
period 1930 to 2029. 
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Feature Description of Change 

Conditional Formatting 
on a Form 

You can now format a field on a form so that its formatting 
changes depending on its current value.  (Editing forms is 
covered in the Intermediate Access 2000 manual). 

Subdatasheets in 
Tables 

This is another useful new feature.  If two tables are linked 
together in a one to many relationship, you can actually 
view the data from the sub-table in the main table. 

 

Printing The Print button now prints out the whole of the current 
object (ie table, query, form or report) without opening the 
Print dialog box. 

Page Setup Print Setup is now called Page Setup (in the File menu).  
This is where you go to change the page orientation, size 
and margins. 

Print Relationships You can now print out the relationships between the tables 
in your database. 

Converting Old 
Databases 

You can covert old Access databases to Access 2000.  
You can also convert an Access 2000 database down to 
Access 97 if you need to share it with an Access 97 user. 

Access Pages Pages are a new type of Access object (like tables, queries 
and forms). 

A Page is like a web form, allowing people to input data 
into an Access database via the Internet (or Intranet) using 
a web browser such as Microsoft Explorer. 
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STARTING ACCESS 2000 

Access 2000 can be started up using the Start button. 

• Click on the “Start” button, select “Programs” and then select “Microsoft 
Access” 

The Microsoft Access window will open up…  

 
… and then a dialog box will appear asking you if wish to open an existing database or 
create a new one. 

This manual does not cover creating a new database (see the Intermediate Access 
2000 manual). 

• Select “Open an Existing 
Database” 

The four most recently used databases are 
shown in the list.  If the database you wish 
to open is shown in the list. 

• Select the database 

• Click “OK” 

If the database is not shown in the list you 
can use the More Files option to locate all 
other databases. 

• Select “More Files” 

• Click “OK” 

 

The Open dialog box will appear. 
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The Open Database dialog box allows you to open any existing Access database. 

 

• Navigate through the folder structure to select the folder the database is 
stored in 

The Access databases stored in that folder will be displayed. 

• Select the database 

• Click "OK" 

The database will open up in the Database Window. 

 
 

To Close A Database 

• In the "File" menu, select "Close" 

 

To Open Another Database 
You can only have one database open at a time.  If you already have one open, it will 
automatically be closed when you try to open another. 

• In the "File" menu, select "Open" 

The Open Database dialog box will appear.  Follow the steps shown above. 

 

To Exit Out Of Access 

• In the "File" menu, select "Exit" 
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THE DATABASE WINDOW 

When you open an existing database, the first window you will see is the Database 
window. 

The Database window 
contains the seven different 
elements of an Access 
database: Tables, Queries, 
Forms, Reports, Pages, 
Macros and Modules. 

 

 
 

Each element is accessed through a tab on the left of the window.   

The Tables tab is currently selected, so that all the tables of the database are visible. 

 

Here is a brief description of each element. 

Element Function 

Tables Tables are the key part of the database.  Tables are used to store all 
the information that is contained in the database. 

Queries Queries are the questions that you ask your database about the data 
stored in it.  To run a query is to extract a particular set of information 
from the database. 

Forms Forms are used to provide an easy way to view or enter data into the 
database.  You can input data straight into the Tables.  But Forms 
can be created containing colours, design elements and drop down 
menus, that make it easier to enter new data. 

Reports Reports are used to print out data from your database.  You can print 
out Tables and Queries as well, but Reports can be formatted to 
produce more professional looking documentation. 

Pages Pages are Internet/Intranet Forms.  They can be used to input data 
into an Access database via the Internet (or Intranet) using a web 
browser such as Microsoft Explorer. 

Macros Macros are an advanced way of automating common tasks in the 
database. 

Modules Modules are an advanced way of automating common tasks in the 
database using Visual Basic programming. 
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TABLES 

Tables are the main part of the database.  Tables are used to store all the information 
that is contained in the database.   

You can have many tables in a database, and you can tell Access the relationships 
between the data in each table so that it can link all the tables together. 

Access Tables look similar to Excel spreadsheets (a grid of intersecting rows and 
columns). 

To Open A Table 
The database tables are visible in the Tables tab in the Database window. 

• Click on the Tables tab 

 

• Select the table  

• Click on the "Open" button  

The Table will open up, containing many 
basic windows elements that you will be 
familiar with from Word or Excel. 

Row
(Record)

Column (Field)Menu BarTitle Bar

Toolbar

Horizontal 
Scroll Bar

Record 
Selector

Minimise Maximise

Vertical
Scroll Bar

Close

 

Title Bar 
The blue Title Bar contains the name of the application (Microsoft Access) and the 
name of the table currently open. 

Menu Bar 
The Menu Bar allows you to access all the 'commands' that are used to make things 
happen in your database. 

Toolbar 
The Toolbar contains buttons that are shortcuts for actions that can otherwise be 
performed through the menu commands. 
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Maximise, Minimise & Close Buttons 
the Maximise, Minimise and Close buttons are used to control the size of the Access 
window.   

The Minimise button is used to minimise the window down to a small button on the 
Taskbar at the bottom of the screen.  Click on the button to open the window up again. 

The Maximise button is used to maximise the size of the Access window, to make it fill 
the screen.    The button will then change to the Restore button.  Click on the Restore 
button to return the window to its previous size. 

The Close button is used to exit out of Access. 

Row 
Each row in the table represents one Record of information.  For example, in our Staff 
List table, each record contains information about one member of staff. 

Column 
Each column in the table contains Fields.  The information in the fields in one column 
all relate to one fact or type of information.  For example, in our Staff List table, each 
field in the third column contains the surname of each member of staff. 

At the top of each column is a Field Heading, describing the type of data stored in the 
column. 

 

For example - in our Staff database, the Staff List table contains information about the 
people working at a company - each row in the table contains data relating to one 
person, and each column will contain data relating to different facts about each 
person, such as Surname, Department, Date of Birth, Sex, etc. 

Vertical Scroll Bar 
The Vertical Scroll Bar is used to move up and down the table.  Click on the up arrow 
at the top of the bar to scroll up.  Click on the down arrow at the bottom of the bar to 
scroll down. 

Horizontal Scroll Bar 
The Horizontal Scroll Bar is used to move left and right across the table.  Click on the 
right arrow to scroll right.  Click on the left arrow to scroll left. 

Fields

Records
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VIEWING THE DATA 

You can use the Vertical Scroll bar to scroll up and down the table.  If there are a large 
number of fields (columns) of data, you can use the Horizontal Scroll Bar to scroll, left 
and right, across the table. 

You can also use the Record Selector at the bottom of the screen to move between 
records. 

Current
Record

New
Record

Next
Record

Previous
Record

First
Record

Last
Record

Total
Number of
Records

 

First Record Returns you to record 1 

Previous Record Moves you back one record 

Current Record Displays the record currently selected.  You can click in this 
area and type the record number you would like to move to, 
then press [Return] 

Next Record Moves you forward one record 

Last Record Moves you to the last record in the table 

New Record Creates a new record at the bottom of the table 

Total Number of 
Records 

Displays the total number of records in the table 

 

Navigation Commands 
There are some keyboard navigation commands that can be used to move around the 
table. 

[Tab] Moves you to the next field 

[Shift]+[Tab] Moves you to the previous field 

[Home] Moves you to the first field in the current record 

[End] Moves you to the last field in the current record 

Arrow Keys Move you up, down, left and right by one field 

[Ctrl]+[Home] Moves you to the very first field in the table 

[Ctrl]+[End] Moves you to the very last field in the table 

[Page Up] Moves you one screen view up the table 

[Page Down] Moves you one screen view down the table 

[Ctrl]+[+] Moves you to the new blank record at the bottom of the table 
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SUBDATASHEETS 

Subdatasheets are a handy new feature in Access 2000. 

If a table is linked to another table, you can view and edit the data from both tables in 
the main table. 

The expand subdatasheet control at the beginning of a record  allows you to view 
the subdatasheet for that record. 

 

 

To View The Subdatasheet 

• Click on the Expand control for the appropriate record  

 

To Hide The Subdatasheet 
When the subdatasheet is showing, the expand control changes to the collapse 
control. 

• Click on the Collapse control  
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SELECTING DATA 

You can select fields, records and columns in any table. 

The Field Headings are used to select columns.  The Record Selectors are used to 
select records. 

Column Selector
(containing Field Heading)

Record
Selector

 

You will need to select data if you wish to delete it, move it or copy it. 

 

☺TIP  You can copy and paste data from an Access table into any Word document 
or Excel spreadsheet (see section on Copying Data to Word or Excel). 

 

These are the techniques for selecting data: 

 

Selection Method 

One Record Click on the record selector at the beginning of the record. 

Several Records Click and drag down across the record selectors. 

Every Record In the "Edit" menu, select "Select All Records".  Or use the 
[Ctrl]+[A] command. 

One Column Click on the Column Selector (containing the field heading) at 
the top of the column. 

Several Columns Click and drag across the field headings at the top of the 
columns. 

One Field Position the cursor at the very beginning of the field, so that the 
cursor changes to a white cross, and click. 

Several Fields You can use the Excel method of dragging across the fields to 
select them, but only if you position at the very beginning of the 
first field, so that the cursor changes to a white cross.  Then 
click and drag across all the fields you wish to select. 
Alternatively you can click in the first field, then hold down the 
[Shift] key and click in the last field. 
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ENTERING DATA 

You can create new records at the bottom of the table, or edit existing records. 

To Edit An Existing Record 

• Click in the field you wish to edit, to insert the flashing Text Insertion Point 

You can then use the [Backspace] key to delete text to the left of the flashing line, or 
the [Delete] key to delete text to the right of the flashing line.  You can also use the left 
and right arrow keys to move left and right, one character at a time, through the text. 

• Type in the appropriate changes 

The changes made to any row are automatically saved when you move out of that row. 

When you edit a row, the  symbol appears in the record selector for that row.  This 
symbol means that the row is being edited.  When you move out of the row, the edit 
symbol disappears, and the changes to that row are saved. 

 

Creating A New Record 

• Click on the "New" button  

You will be moved to the empty row at the bottom of the table.  You can use the [Tab] 
key to move through the fields in the row. 

• Type in the new data 

 

☺TIP  You can use the [Ctrl]+['] command to automatically enter the same text into 
a field that appears in the field directly above. 

 

Drop Down Lists 
A new feature in Access 2000 allows you to create a drop down list in a table.   

If a drop down list has been 
created for a field, an arrow will 
appear when you click in that 
field. 

• Click on the arrow to 
bring up the full list 

• Click in the list to select 
the appropriate value 

 

Your selection will be entered into the field. 
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Tick Boxes 
Check boxes in Access 2.0 tables have been replaced with tick boxes in Access 2000 
tables.  These are used in fields which can only contain a yes or no value.   

For example, is the person a car user. 

 

A tick means yes, an empty box means no. 

• Click in the box to add and remove the tick 

 

 

To Delete A Record  
You cannot always delete records in a table.  It depends on how the table was set up, 
or whether old data is kept for archiving purposes.  Ask the owner of your database if 
you should delete records. 

• Select the record 

• In the “Edit” menu, select “Delete” or press the [Delete] key 

A dialog box will appear, asking you if you are sure you wish to delete the record. 

 

• Click "Yes" 
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HIDING, SHOWING AND RESIZING COLUMNS 

If there are a lot of columns in a table, you can hide columns to make it easier to 
navigate around the table. 

To Hide A Column(s) 

• Select the column(s) 

• In the "Format" menu, select "Hide Columns" 

The selected columns will now be hidden. 

To Unhide Hidden Columns 

• In the "Format" menu, select "Unhide Columns" 

The Unhide Columns dialog box will appear.  
This contains a list of all your column 
headings.  The column headings without a 
tick by them are not showing in the table. 

• Click on the box next to the Column 
Heading to add a tick 

• Repeat for each column you wish to 
unhide, then click on the "Close" 
button 

 

To Resize A Column 
Columns are resized using the right side of the column selectors, at the top of the 
column. 

 

• Position the cursor at the right side of the column selector for the column 
you wish to resize 

• Click and drag to the right to increase the width, or to the left to decrease the 
width 

To Move A Column 
You can change the order of the columns in a table. 

• Click on the column selector to select the column (and then release the 
mouse button) 

• Click and drag on the column selector to move the column 
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PRINTING TABLES 

You can print out a whole table, or just a few records or columns of information. 

To Print The Whole Table 

• Click on the "Print" button  

To Print Part Of The Table 
Select the fields, records or columns that you want to print. 

• In the “File” menu, select “Print” 
The Print dialog box will appear. 

You can use the Print Range 
options to control how much of the 
table is printed: 

All - prints the whole table 

Selection - prints just the selected 
records or columns 

Pages - allows you to specify a 
range of pages if the table is too big 
to fit on one page 

• Select the appropriate Print 
Range 

• Click "OK" 

 

PAGE SETUP OPTIONS 
You can change the page setup options to make the table print out on portrait or 
landscape paper. 

To Set Landscape Or Portrait Paper 

• In the "File" menu, select "Page Setup" 

The Page Setup dialog box will appear. 

• Click on the “Page” tab 

• In the Orientation options, select Portrait or 
Landscape 

• Click “OK” 
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PRINT PREVIEW 

Print Preview can be used to see how a table will look when it is printed out.   

• Click on the "Print Preview" button  

The Print Preview screen will appear, showing how the table fits on the A4 page. 

 

You can click on the page to zoom in to see the page in more detail.  Then click again 
to zoom out. 

These are the main buttons you will need to use on the Print Preview toolbar. 

ClosePrint Zoom

 

Print - prints the whole table out. 

Zoom - zooms you in and out on the page. 

Close - closes Print Preview and returns you to your table. 

You can use the page navigation buttons at the 
bottom of the window to see how many pages 
the data will print out on. 

Previous
Page

Next
Page

First
Page

Last
Page

 

To Close Print Preview 

• Click on the “Close” button on the Print Preview toolbar   
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COPYING DATA TO WORD OR EXCEL 

You can copy all, or part of, the data in your table into Word or Excel. 

Copying Data To Word 

• Use the Record Selectors or the Field Selectors to select the rows or 
columns you wish to copy 

• Click on the “Copy” button   

• Open Word 

In Word. 

• Click in the document text to choose the insertion point 

• Click on the “Paste” button  

The data will be pasted into your document as a Word table. 

 

 

Copying Data To Excel 
In your Access table. 

• Use the Record Selectors or the Field Selectors to select the rows or 
columns you wish to copy 

• Click on the “Copy” button   

• Open Excel 
In Excel. 

• Click in the spreadsheet to choose the insertion point 

• Click on the “Paste” button  

The data will be pasted into your spreadsheet. 
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FINDING DATA 

The Find facility allows you to locate specific data in your table quickly. 

The Find facility also contains Find and Replace, used to find all the occurrences of a 
particular word and to replace it with something else. 

To Find Data 
If you know which field contains the data you wish to search for, and you wish to 
search the whole column from the top. 

• Click in the first cell in the column you wish to search 

• Click on the "Find" button  

The Find dialog box will 
appear. 

• In the Find What 
box, enter the text 
you wish to find 

 

 
 

The Look In field specifies which field to search through.  This will display the last field 
you clicked in.  But you can change it to select the whole table. 

 
The Match control allows you choose how the find text must match the contents of the 
field. 

Whole Field – looks for fields that contain exactly the text entered in the Find What 
box. 

Any Part of Field – looks for fields that contain at least the text entered in the Find 
What box. 

Start of Field – looks for fields that start with the text entered in the Find What box. 

 
• Select the appropriate options 

• Click on the "Find Next" button to find the next instance of the search text 
(starting from the cell you last clicked in) 

Access will find and select the field containing this text in your table. 

• Click on the "Find Next" button to find each subsequent instance of the search 
text 

If you keep clicking, a message will appear that Access has finished searching. 

• Click “OK” to get rid of the message 

• Click on the "Cancel" button to close down the Find dialog box 
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FIND AND REPLACE 
Find and Replace is used to find all the occurrences of a particular word (or number or 
date) and to replace it with something else. 

 

To Find And Replace Data 
If you know which field contains the data you wish to find and replace, and you wish to 
search the whole column from the top. 

• Click in the first cell the column you wish to search 

• Click on the "Find" button  

The Find dialog box will appear. 

• Select the 
“Replace” tab 

• In the Find What 
box, enter the text 
you wish to find 

• In the Replace With 
box, enter the text 
you wish to replace 
it with 

• Click on the “Find Next” button to find the next instance of the Find What text 

• Click on the “Replace” button to replace it with the contents of the Replace 
With box 

 

☺TIP  You can click on the “Replace All” button to replace every occurrence of the 
text. 

 

• Click on the “Cancel” button to close the dialog box 
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SORTING THE TABLE 

The Sort facility allows you to sort your data into alphabetical or numerical order. 

There are two sort buttons on the Table Toolbar. 

Sort
Ascending

Sort
Descending

 

 
Sort Ascending Sorts text alphabetically from A to Z. 

 Sorts numbers from lowest to highest. 

 Sorts dates from earliest to most recent. 

Sort Descending Sorts text from Z to A. 

 Sorts numbers from highest to lowest. 

 Sorts dates from most recent to earliest. 

 

To Sort The Table 

• Click in the column you wish to sort by 

• Click on the "Sort Ascending" or the "Sort Descending" button 

 

In Access 2000, the sort order of records is now saved when you save the layout of a 
table, so that the records will appear in the saved order when you next open the table. 
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QUERIES 

Queries are the questions that you ask your database about the information stored in 
it.  To run a query is to extract a particular set of data from the database. 

Queries allow you to view particular data, analyse the data and even make edits to the 
data.  

You can view the data from just one table, or you can view data from several tables. 

For example, in our Staff2000 database, you could run a simple query to ask the 
database to show you the first name, surname and date of birth of all staff. 

The results of a query are called a Dynaset.  A dynaset is a datasheet that looks like a 
table, but is not.  It is a dynamic view of data that is actually stored in one or more 
tables.  It is dynamic because changes made to the query dynaset will affect the data 
tables. 

CHANGES TO THE QUERY DATA WILL ALSO CHANGE THE UNDERLYING TABLE 
DATA. 

Queries are usually based on tables, but you can base a query on another query. 

 

Sorting 
When you create a query it is often easier to read the data if the records are sorted 
into some alphabetical or numerical order.  You can sort a query by any field. 

 

Criteria 
More complicated queries involve the use of Criteria.  Criteria are used to extract only 
records that match certain conditions.  For example, you could run a query to extract 
the first name and surname of only the staff who work at the Grove office. 

 

Calculations 
You can perform calculations in queries.  For example to create totals, averages or 
count the number of records that match a certain criteria. 
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CREATING A QUERY 

There are four main steps to create a new query: 

1. Select the table(s) you wish to extract the data from 

2. Choose which data fields you wish to extract from the selected table(s) 

3. Establish the criteria (if any) of the data you wish to extract 

4. Run the query 

To Create A New Query 
New queries are created in the Query tab in the Database window. 

• In the Database window, click on 
the "Query" tab 

• Click on the "New" button 

 

 

The New Query dialog box will appear. 

It is more versatile if you create queries in 
Design View.  

• Select Design View 

• Click “OK” 

The Add Table dialog box will appear.  This 
is used to choose which tables you wish to 
extract data from. 

You can extract data from one table, or 
from several. 

• Click to select a table 

• Click on the "Add" button 

Repeat these steps for each table you wish 
to add. 

• Click on "Close" 
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The Query window will appear, containing a Field List for each table you selected and 
the QBE grid (Query By Example). 

Each Field List contains the field headings for each column of data in the selected 
table.  The name of the table is shown at the top of the Field List box.  You can use 
the vertical scroll bar, on the right of the box, to view all the field names. 

Field List

Field Row

QBE Grid

Table Row
Sort Row
Show Row
Criteria Row  

The QBE grid is used to choose the data that is extracted from the database.   

Field Row - is used to choose which fields of data are extracted. 

Table Row - is used to specify which table each selected field is located in 

Sort Row - is used to sort the extracted data into alphabetical or numerical order (see 
section on Sorting a Query). 

Show Row - is used to show or hide the data for a particular field.  This is used in 
conjunction with Criteria to enable you to filter data using a particular field, without 
showing data from that field in the final query (see section on Criteria). 
Criteria Row - is used to extract only certain records in a particular field (see section 
on Criteria). 

 

To choose which fields are displayed in the query, you add the field names into the 
Field Row in the grid. 

• Click and drag each field name from the Field list into the first empty cell in 
the Field Row. 

Having chosen all the fields that you want to appear in your query, you can run the 
query. 

• Click on the "Datasheet View" button on the toolbar to view the query results 

 

The query datasheet will appear. 
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You may now want to print the query.  You may also want to save the query. 

 

 

To Print The Query 

• Click on the "Print" button  

 

The query will be sent straight to the printer. 

 

 

To Save The Query 

• Click on the “Save” button  

The Save As dialog box will appear. 

 
Query names can be longer than 8 characters, and they can have spaces in them.  It 
is good practice to save all queries with a name beginning with the letters "qry".   

• Enter a name for the query 

• Click "OK" 
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To Close A Query 

• In the "File" menu, select "Close" 

The query will then be visible in the Query tab in the Database window. 

 
 

To Open A Query 
Each time you open a query it displays the most up to date information from the 
underlying tables. 

• Select the Query tab in the Database window to view the existing queries 

• Select the query you wish to open 

• Click on the "Open" button 

 

Changing A Query 
If you wish to redefine the fields (or criteria) used in an existing query, you will need to 
open the query in Design view. 

If the query is closed, you can open it straight up in design view. 

• Select the query in the Query tab in the Database window 

• Click on the "Design" button 

 

 

Switching Between The Query Datasheet View And Design View 
If the query is open you can switch between the query datasheet view and the query 
design view using these toolbar buttons. 

Design View   Datasheet View   

 

• Click on the "Design View" button to view the query design 

• Click on the "Datasheet View" to view the query results 
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USING CRITERIA IN A QUERY 

Criteria are used to control and limit the amount of information that is extracted from 
the database when you run a query.  It is a way of filtering out the data you want from 
the data you don't want. 

For example, in our Staff database, you could run a query to show the first names, 
surnames and office location of only the staff who work at the Grove office. 

Criteria are entered into the Criteria row in the query QBE grid. 

Criteria Row

 

The text that is entered into the Criteria row limits the query to only records that match 
the text for that particular field. 

For example - to limit the query to only staff whose Office is Grove, you must enter the 
text Grove into the Criteria row underneath the Office field (it will change to "Grove"). 

You can enter the text in a variety of different formats that will all work.  These are: 

Grove =Grove "Grove" ="Grove" 

You can also enter numbers into the Criteria Row, in the format: 

100 =100 

You can also enter dates into the Criteria Row, in the format: 

16/1/98 16 Jan 98 =16/1/98 #16/1/98# =#16/1/98# 

 

To Use Criteria In A Query 
In the QBE grid, in the Query window. 

• Enter the criteria text/number into the Criteria Row, underneath the field 
name that it relates to 

• Click on the "Datasheet View" button on the toolbar to view the query results 

 

The query will appear in its own window. 

 

The next section contains examples of how criteria can be used. 
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CRITERIA EXAMPLES 

You can use text, numbers and dates in criteria. 

You can use Operators to look for data that is 'equal to', 'greater than' or 'less than' 
certain values. 

You can also use Wildcard Characters in criteria to represent any one character or 
any string of characters. 

 

Operators 
Operators are used to specify whether you look for data that is equal to, more than, 
less than, etc, the criteria value.  These are the basic operators: 

= equal to <> not equal to 

> greater than >= greater than or equal to 

< less than  <= less than or equal to 

 

Wildcard Characters 
There are two wildcard characters that can be used in criteria.  These are the ? and * 
symbols.  When using wildcard characters you will also need to use the expression 
Like instead of the = symbol (otherwise the query looks for fields actually containing 
an asterisk or question mark). 

? represents any one text character.  For example using Like "c?t" would bring up 
fields containing cut, cot, and cat. 

* represents any string of characters.  For example using Like "work*" would bring up 
fields containing works, worker, workers, working, workings and worked. 

 

TEXT EXAMPLES 

Expression Things Found By Query 

"Grove" All fields containing exactly Grove 

Not "Grove" All fields not containing exactly Grove 

Like "J*" All fields that start with the letter J 

Like "*Road" All fields that end in the word Road 

Like "[A-C]*" All fields starting with the letters between A and C 

Null All blank fields 
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NUMBER EXAMPLES 

Expression Things Found By Query 

=50 Numbers equal to 50 

>50 Numbers greater than 50 

<50 Numbers less than 50 

>=50 Numbers greater than or equal to 50 

<=50 Numbers less than or equal to 50 
 

DATE EXAMPLES 

Expression Things Found By Query 

=1/6/1998 Fields containing 1 June 1998  

=#01/06/1998# Fields containing 1 June 1998  

>1/6/1998 Dates later than 1 June 1998 

<1/6/1998 Dates earlier than 1 June 1998 

<=1/6/1998 Dates earlier than or equal to 1 June 1998 
 

THE SHOW BOX 
Just because you are using a field in your query does not mean that you want to 
display it in the query results.  For example you may wish to create a query that shows 
the dates of birth for all staff at the Grove office without having to display the fields 
containing the Office data. 

The Show boxes in the QBE grid control which fields are displayed in the query.  Each 
box is turned on by default for each field. 

Show Boxes

 

To Hide Fields In A Query 

• Click in the Show box to turn it off (by removing the tick) 
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SPECIFYING MULTIPLE CRITERIA 

A simple criteria will contain one criteria in one field.  But you can specify several 
criteria in one field or several criteria for several fields.  This allows you to create more 
complex queries. 

SEVERAL CRITERIA IN SEVERAL FIELDS 
For example you could run a query to display the names of all staff who work at the 
Grove office and whose date of birth is after 1/1/65. 

 
• Enter the appropriate criteria in the Criteria row for each field you wish to 

filter by 

SEVERAL CRITERIA IN ONE FIELD 
For example you could run a query to display the names of all staff who work at the 
Grove office or at the Windmill office. 

 
To specify multiple criteria, in the same field, use the And and Or operators. 

Use And when you want to find records that match both criteria. 

Use Or when you want to find records that match either criteria. 

• Enter the appropriate criteria into the same cell in the Criteria row, separated 
by the And or Or operators 

Examples Of Several Criteria In One Field 

Expression Things Found By Query 

"Grove" Or "Windmill" All fields containing exactly Grove or exactly Windmill 

Like "A*" And Like "*S" Fields starting with an A and ending with an S 

>=50 And <=100 Numbers between 50 and 100 (including 50 and 100) 

Between 50 And 100 Numbers between 50 and 100 (including 50 and 100) 

Between 1/6/98 And 
30/6/98 

All dates between 1 June 98 and 30 June 98 (including 1 
June and 30 June) 
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SORTING A QUERY 

You can choose to sort a query by any text, number or date field. 

You can perform an Ascending sort on data, or a Descending sort. 

Ascending Sorts text alphabetically from A to Z. 
 Sorts numbers from lowest to highest. 
 Sorts dates from oldest to most recent. 

Descending Sorts text from Z to A. 
 Sorts numbers from highest to lowest. 
 Sorts dates from most recent to oldest. 

To Sort A Query 

• Click in the Sort cell, underneath the Field you wish to sort by 

This will bring up a drop down menu arrow  

• Click on the drop 
down menu arrow, 
and select the 
Ascending or 
Descending sort 
option 

When you run the query, the resulting dynaset will be sorted by the field you specified. 

SORTING ON SEVERAL FIELDS 
You can sort by more than one field at a time.  This is useful if there is identical data in 
the main sort field for any records.  For example if you sort by surname, if any people 
share the same surname you will then need to sort them by some other field, ie by first 
name. 

The priority of the fields 
sorted is determined by 
their order in the QBE 
grid.  The first sorted field 
(from the left) is the main 
sort field.  The next sorted 
field is the secondary sort 
field, etc. 

1st Sort Field 2nd Sort Field

• Ensure that the first field you wish to sort by appears in the QBE grid before 
the other fields you wish to sort by 

• Click in the Sort cell, underneath each Field you wish to sort by 

This will bring up a drop down menu arrow  

• Click on the drop down menu arrow, and select the Ascending or Descending 
sort option 

When you run the query, the resulting dynaset will be sorted by the fields you 
specified. 
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PERFORMING CALCULATIONS IN A QUERY 

You can use a query to calculate totals, averages or to count the number of records 
that satisfy certain criteria. 

You cannot create a query that lists all the data AND performs a calculation at the same 
time. 

To perform a calculation in a query you must decide which field you wish to group the 
information by (eg by office, department or sex, etc) and which field contains the data 
you wish to total, average or count.   

If you wish to total everything, you should put only the field containing the values you 
wish to total in the query. 

To Perform A Calculation In A Query 

• Create the query in the normal way 
and add the field you wish to group 
the data by, and the field you wish 
to perform the calculation on 

• Click on the "Totals" button  

The Total row will appear in the query grid.   

The 'Group By' function will appear in this row for each field. 

• Click in the Total row for the field you wish to perform the calculation on 

A drop down arrow will appear. 

• Click on the drop down arrow 

A list of all the available calculations 
(functions) will appear. 

Sum - calculates a total. 
Avg - calculates an average. 
Count - counts the number of records. 

• Select a function 

 

 

• Click on the "Datasheet View" 
button to view the query results 

 

 

The results of the query will appear. 
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Examples 
Here are some examples of queries that perform calculations. 

 
This calculates the average salary for 
each ethnic category. 

 
This calculates the total salary for all staff. 

 
This counts the number of people in each 
department. 

 
This counts the number of staff living in 
W6. 

 

 

☺TIP  You can change the headings that appear at the top of a query by using an 
Alias. 

 

USING AN ALIAS IN A QUERY 
Instead of having a heading such as 
AvgOfSalary, or SumOfLastname, in your 
query results, you can create a different 
heading. 

This is done in the Field row in the query 
grid. 

 

• Enter the name you wish to appear 
followed by a colon, a space and 
then the field name 
 
eg   Average Salary: Salary 

 

When you run the query, the name before 
the colon will appear in the query datasheet 
as the column heading.  
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FORMS 

Forms are used to input or look up data in the database tables. 

Forms are often used instead of Tables because they are versatile and can be 
customised to create a more user-friendly screen in which to work. 

Forms display fields for one record at a time. 

Here is an example of a 
Form than could be 
used to input data into 
the Staff List table. 

 

This manual does not cover how to create new Forms (see the Intermediate Access 
manual).   

This chapter is designed to introduce you to the concept of a Form as any database 
you have to use will probably contain some sort of Form.   

 

To Open A Form 
Existing Forms are visible in the Forms tab in the Database window. 

• Click on the Forms tab to view the existing Forms 

• Click to select the form you wish to open 

• Click on the "Open" button 

The Form will open up. 

 

Form design is so versatile that two Forms could be made to look very different from 
each other.  Thus it is hard to document the Forms you may have to work with.  But 
there are certain elements that are present on most Forms, regardless of the style of 
the Form. 



www.ebitsolutions.net     SEPTEMBER 1999 EBIT SOLUTIONS LIMITED 
 
 

 
  BASIC ACCESS 2000 34 

USING A FORM 

A Form displays information for one record at a time from a particular table (or a 
combination of tables). 

Each form contains Fields that link directly to the fields in the underlying table.  The 
Field Label describes the data stored in the field. 

Record 
Selector

Field
Label

Field

Record 
Selector

Field
Label

Field

 

The information entered into the form fields are entered into the corresponding table 
fields, enabling you to use the form to view and edit the data in the underlying table. 

To Move Between Records 
The Record Selector at the bottom of the form is used to move between the records in 
the form.  This works in exactly the same way as for a table. 

Current
Record

New
Record

Next
Record

Previous
Record

First
Record

Last
Record

Total
Number of
Records

 

First Record Returns you to record 1 

Previous Record Moves you back one record 

Current Record Displays the record currently selected.  You can click in this 
area and type the record number you would like to move to, 
then press [Return] 

Next Record Moves you forward one record 

Last Record Moves you to the last record 

New Record Creates a new blank record 

Total Number of 
Records 

Displays the total number of records 
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To Move Between Fields 
There are some keyboard navigation commands that can be used to move around the 
form. 

[Tab] Moves you to the next field 

[Shift]+[Tab] Moves you to the previous field 

[Home] Moves you to the first field in the current record 

[End] Moves you to the last field in the current record 

Arrow Keys Move you up, down, left and right by one field 

[Ctrl]+[Home] Moves you to the first field of the first record 

[Ctrl]+[End] Moves you to the last field of the last record 

[Ctrl]+[Page Up] Moves you to the same field on the next record 

[Ctrl]+[Page Down] Moves you to the same field on the previous record 

[Ctrl]+[+] Moves you to the new blank record 
 

 

To Enter Data 
The method of entering data into each field can vary slightly depending on the type of 
field control used.  The different types of field controls are listed on the next page. 

• Enter text or select the appropriate option 

 
 

To Close A Form 

• In the "File" menu, select "Close" 
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FIELD CONTROLS 

There are several different types of field control that can be used in a form.  You will 
be familiar with these control types as they are consistently used across all Microsoft 
programs for making choices and inputting text in dialog boxes.   

The most common field controls are: text boxes, drop down menus, scrolling menus, 
option buttons and check boxes. 

Text Box 
The text box is probably the most common 
field control.  You can type text, numbers or 
dates directly into the text box.   

 
 

(There may be restrictions on the text box to stop you from entering too much text or 
an 'Input Mask' to force you to enter dates in the correct format). 

Drop Down Menu (Combo Box) 
Drop Down Menus are used to provide you 
with a list of available options.  The list is 
accessed by clicking on the drop down arrow 
at the right of the box.  You then click on the 
appropriate option in the list to select it. 

If there is no appropriate option in the list you 
can type something different into the box at 
the top of the list. 

 
 

 

Scrolling Menu (List Box) 
Scrolling Menus are used to provide you with 
a list of available options and to force you to 
choose one of those options. 

If the list is long a scroll bar will appear on 
the right to enable you to scroll up and down 
the list.   

Click to select the appropriate option. 

 

Option Buttons 
Option buttons are another way of presenting 
you with a list of options out of which you can 
only choose one.   

Click on the appropriate button to select the 
option.  

Check Boxes 
A Check Box is a yes/no option.   

Click on the box to add a tick (yes).   
Click again to remove the tick (no). 
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A MAIN/SUBFORM 

A Main/Subform is used to display and edit data from two separate tables that are 
linked together. 

The following picture shows a main/subform containing staff training details. 

Main
Form

Subform

Subform
 Record Selector

Main Form
Record Selector  

The main form contains data about each staff member.   

The subform contains data about the training courses attended by the staff member 
selected in the main form (displayed in Datasheet view). 

Because there are two forms displayed, there could be two separate record selectors 
to navigate through the records in each form. 

The main form record selector buttons move you through the records of each staff 
member. 

The subform record selector buttons move you through the records of the training 
courses attended by the staff member showing in the main form. 

To Move Between Records On The Main Form 

• Click on the left and right arrow buttons on the Main Form Record Selector 

To Move Between Records On The Subform 

• Click on the left and right arrow buttons on the Subform Record Selector 

To Close The Form 

• In the "File" menu, select "Close" 
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REPORTS 

Reports are used to print out data from the database in a format that is meaningful or 
simply more attractive to look at than a table. 

Reports are based on a tables or queries. 

Reports can also be used to perform calculations on data (totals and subtotals) and to 
create mailing labels. 

Once a report has been created it will update to display the latest data in the database 
each time you open it. 

TYPES OF REPORT 
There are five default report types that you can use to quickly create a report. 

The Columnar AutoReport and Tabular AutoReport create the report for you 
automatically once you have selected the table or query you wish to base the report 
on. 

The Report Wizard, Chart Wizard and Label Wizard take longer to create the report, 
but are more versatile.  A series of dialog boxes will appear to guide you through the 
creation process. 

 
These are the two AutoReports: 

Columnar AutoReport 
The Columnar AutoReport displays 
fields in a single column spreading 
down the page. 

(See section on creating an 
AutoReport). 

 

Tabular AutoReport 
The Tabular AutoReport displays 
each record as a row of fields. 

(See section on creating an 
AutoReport). 
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These are the three report wizards. 

Report Wizard 
The Report Wizard is the most 
versatile wizard.   

It can be used to create a report 
that contains sorting, grouping or 
calculations. 

(See section on Using the Report 
Wizard). 

 

Label Wizard  
The Label Wizard creates mailing 
labels using the standard Avery 
label sizes.  

In Access 2000 you can also 
create customised labels in case 
you are not using Avery labels. 

(See section on Creating Mailing 
Labels). 

Chart Wizard 
The Chart Wizard creates a chart 
based on some numerical data. 

Creating a Chart Report is not 
covered in this manual. 

It takes a lot of tweaking to get a 
chart to look good, so I would 
suggest exporting the data to 
Excel and creating the chart in 
Excel (see section on Exporting a 
Report to Word or Excel). 

 

New and existing reports are accessed through the Report tab in the Database 
window. 
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CREATING AN AUTOREPORT 

New and existing reports are accessed through the Report tab in the Database 
window. 

• Click on the "Report" tab 

• Click on the "New" button 

 

The New Report dialog box will open up. 

 

The New Report dialog box is used to 
choose which type of report you wish to 
create 

• Select AutoReport Columnar or 
AutoReport Tabular 

You must now choose which table or 
query you wish to base the report on. 

• In the ‘Choose a Table or 
Query…' drop down list select 
the table or query you wish to 
base the report on 

• Click "OK" 

 

 

The report will automatically be created 
containing all the fields that appear in the 
selected table or query. 

 

The name of the table or query that the 
report is based on will automatically 
appear as a title at the top of the report. 

 

 

☺TIP  If you do not wish the report to contain all the information in a table, or if you 
wish to create a report that is based on more than one table - create a query 
that extracts the relevant data first, then base the new report on that query. 
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SAVING, CLOSING, OPENING AND PRINTING REPORTS 

The finished report appears in its 
own 'Print Preview' window. 

You can use the controls at the 
bottom of the screen to move 
through the pages in the report. 

First Page Last Page

Previous Page Next Page

 

If you want to see part of the page in more detail, you can click on the page to zoom 
in.  Click again on the page to zoom out. 

If the report has just been created then it will need to be saved. 

To Save A Report 

• In the “File” menu, select “Save” 

The Save As dialog box will appear. 

It is good practice to start all your report names with the letters “rpt”, eg “rpt Staff 
Phone List”. 

• Enter a name for your report 

• Click “OK” 

The report is now saved with that name, 
and is visible in the Report tab in the 
Database window. 

To Close A Report 

• In the "File" menu, select "Close" 

To Open A Report 
In the Report tab, in the Database Window. 

• Click to select the report, and then click on the "Open" button 

To Print A Report 

• When the report is open, click on the "Print" button  on the toolbar 

The whole report will be sent to the printer.  If you only want to print part of the report, 
you should use the “Print” command in the “File” menu to bring up the Print dialog box, 
and then specify the appropriate print range. 
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EXPORTING A REPORT TO WORD OR EXCEL 

If you do not like the layout or formatting of the report you can edit it in Design view 
(but those steps are not covered in this manual).  Alternatively you can export the 
report to Word or Excel and then use the formatting options in either program to 
customise the report. 

EXPORTING A REPORT TO WORD 
When the report is open on screen. 

• Click on the drop down arrow on the right hand side 
of the "OfficeLinks" button - which might look like…   or  

• In the drop down menu that appears, select “Publish it with MS Word” 

Word will open up with a new document containing your report as a 'tabbed' table.  
You can now use the normal Word formatting options to change the layout of the 
report, and then print and save it as a Word document. 

☺TIP  You can convert a tabbed table into a proper Word table by 
selecting the table and clicking on the “Insert Table” button  

If you wish to keep this document or mail it to anyone else, you need to save it as a 
Word document. 

An exported report appears in Word as an 'Rich Text Format' file rather than a Word 
document. You must use the "Save As" command to save it as a Word document. 

• In the "File" menu, select "Save As" 

The Save As dialog box will appear. 

• Enter a File Name and choose the folder you wish to store the document in 

• In the "Save As Type" drop down menu, at the bottom of the dialog box, select 
Word Document 

• Click "OK" 

EXPORTING A REPORT TO EXCEL 
If the report contains lots of numbers that you want to perform calculations on, or if 
you need to be able to change the column widths of the fields, you may wish to export 
it to Excel.  When the report is open on screen: 

• Click on the drop down arrow on the right hand side 
of the "OfficeLinks" button - which might look like…   or  

• In the drop down menu that appears, select “Analyse it with MS Excel” 
Excel will open up with a new workbook containing your report.  You can now use the 
normal Excel features to format and print the data. 

When you save the workbook, use the "Save As" command to bring up the Save As 
dialog box.  In the "Save as Type" box ensure that 'Microsoft Excel Workbook' is 
selected (not 'Microsoft 5.0/95 Excel Workbook'). 
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USING THE REPORT WIZARD 

The Report Wizard is used to create reports that contain grouping, sorting or 
calculations. 

Because it is so versatile, it is difficult to document this wizard.  The steps that appear 
depend on the number of tables that you base the report on and the type of fields you 
choose to include (ie text or numerical data). 

Here is an example report to display a breakdown of salaries by department (from the 
Staff List table). 

New reports are created in the Report tab in the Database window. 

• Click on the "Report" tab 

• Click on the "New" button 

 

The New Report dialog box will open up.  

The New Report dialog box is used to 
choose which type of report you wish to 
create 

• Select Report Wizard 

You must now choose which table or 
query you wish to base the report on. 

• In the ‘Choose a Table or 
Query…' drop down list select 
the table or query you wish to 
base the report on 

• Click “OK”  

A dialog box will appear, which is used to 
select which fields are shown to be on 
the report.   

The box on the left displays all the fields 
in the table or query you are building the 
report from.  The box on the right will 
contain only the fields you actually wish 
to include in the report. 

• Click in the 'Available Fields' list 
to select a field 

• Click on the "Add" button  to 
add the field to the box on the 
right 

☺  TIP You can double click on a field to add it to the selected fields list. 
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Repeat these steps for each field you wish to add.  The order that you add the fields 
determines the order in which they will appear on the report.  The top field becomes 
the first column on the page. 

If you make a mistake, you can select a field and remove it using the "Remove" button 
. 

☺TIP  To add all the fields in one go, click on the "Add All" button   

When you have added all the fields you wish to display on the report. 

• Click on the "Next" button 

Another dialog box will appear. 

You can now choose to group the data 
by one of the fields included in the report. 

• Select the field you wish to group 
by 

• Click on the “Add” button  

• Click “Next” 
 

 

 

 

Another dialog box will appear. 

You can now choose to sort the data by 
one of the fields included in the report. 

You can actually set up to four sort 
levels. 

• Click in the first sort box and 
select a field to sort by. 

The button on the right of the sort box 
allows you to choose and Ascending (A 
to Z) sort, or Descending (Z to A). 

 

If you have included a number field in the report you will be able to perform Statistical 
Analysis on the data using the Summary Options. 

• Click on the “Summary Options” 
button 

 

The Summary Options dialog box will appear. 
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There are four calculations available: 

Sum - calculates a total. 

Avg - calculates an average. 

Min - displays the minimum value. 

Max - displays the maximum value. 

• Select the appropriate 
calculation 

• Click “OK” 

 

You will then return to the sorting dialog 
box. 

• Click “Next” 
 

 

You can now choose a Layout style for 
the report. 

• Select a Layout style 

You can also choose the Orientation of 
the report. 

• Select Portrait or Landscape 

• Click “Next” 

You can now choose a format style. 

• Select a format style 

• Click “Next” 
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You can now choose a title to appear at 
the top of the report. 

• Enter a title for the report 

Unfortunately the report will also be 
saved with this title as the report name, 
but you can rename the report later. 

• Click on the “Finish” button 

 

The report will appear in the Print 
Preview window. 

You can now print and close the report 

To print the report. 

• Click on the “Print” button  

To close the report. 

• Click on the “Close” button 

 

 

TO RENAME A REPORT 
Reports can be renamed in the Report tab in the Database window. 

• Click once to select the 
report you wish to rename 

• Click again on the report 
name 

This will highlight the whole name. 

You can either type a new name over the old name, or click again to insert the flashing 
text insertion point and then edit the existing name using the left and right arrow keys 
and the [Backspace] and [Delete] keys. 

• Type a new name 

• Press [Return] 
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MAIL MERGE 

You can use an Access database to create mailing labels within Access.  Or you can 
use the database as the data source in a Word Mail Merge to create mailing labels 
and bulk letters. 

USING WORD TO MAIL MERGE WITH AN ACCESS DATABASE 
If you are already familiar with mail merging in Word to create bulk letters or mailing 
labels then you might prefer to use this method to merge with a database. 

The following steps relate to the part of a mail merge (in Word) that deals with linking 
to an Access database (see Word Advanced manual for more instructions).  

In Word, having created your Main Document, you will be ready to attach a Data 
Source. 

• In the "Tools" menu, select "Mail Merge" to bring up the Mail Merge Helper 
dialog box 

• Click on the "Get Data" button, and select "Open Data Source" 

The Open Data Source dialog 
box will appear. 

• In the "Files of Type" 
drop down menu at the 
bottom of the dialog box, 
select MS Access 
Databases 

• Navigate through the 
appropriate folders and 
select the database 

• Click "Open" 

The Microsoft Access dialog will 
open containing a Tables tab 
listing all the tables in the 
database (and a Queries tab 
listing all the queries). 

• Select the table or query 
you wish to merge with 

• Click "OK" 

 
 

You will then asked if you wish to 
Edit the Main Document (to insert 
the Merge Fields). 

• Click "Edit Main 
Document" 

Your Word document is now connected to the Access database.  Follow the usual 
steps to insert your merge fields into the document, and then merge the document 
with the database. 
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CREATING MAILING LABELS IN ACCESS 
If your database contains names and addresses then you may wish to create mailing 
labels.  You can either do this in Word using a Mail Merge that links to your Access 
database (see previous page), or you can create a report in Access to produce the 
mailing labels.  

Mailing label reports are created in the Report tab. 

• Click on the "New" button to create a new 
report 

The New Report dialog box will open up. 

• Select “Label Wizard”  

• In the ‘Choose a Table or Query…' drop 
down list select the table or query that 
contains the names and addresses for the 
labels 

• Click “OK” 

 
You must now tell Access what 
labels you are using. 

If you are using Avery labels, 
you can… 

• Select Avery in the 
Filter by Manufacturer 
list 

• Select the appropriate 
Avery label code 

If the right code is not showing 
you may need to switch 
between English and Metric 
unit of measure. 

If you are using Dudley labels. 

• Click on the Customize 
button 

 
If you clicked on the Customise 
button, you will now have to 
select an existing custom label 
or create a new one (and input 
the label measurements). 

If you wish to work in 
centimetres select the Metric 
option. 

• Click on the “New” 
button 
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These label measurements 
will be saved for later use. 

• Enter a name for the 
labels 

• Enter the label 
measurements 

• Click “OK” 

 

• Click “Close” 

 

• Click “Next” 

You can now specify the text 
formatting for the labels. 

• Select the 
appropriate 
formatting 

• Click “Next” 

You can now choose which 
fields appear on the labels. 

The available fields are 
shown on the left. 

The ‘prototype’ label is 
constructed on the right. 

To add a field: 

• Select the field and 
click on the “Add” 
button  

 

To add a space, new paragraph or other punctuation: 

• Type the appropriate key on the keyboard 

When the prototype label is constructed. 

• Click “Next” 
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You can now choose a 
field to sort the labels by. 

• Select a field and 
then click on the 
“Add” button 

 

• Click “Next” 
 

You can now choose a 
name for the report.  In this 
case this is the name the 
report is saved as (not a 
title). 

• Enter a name for 
the report 

• Click “Finish” 

The label report will open 
in a Print Preview window. 

 

You can now print and 
close the report 

To Print The Report 

• Click on the “Print” 
button 

 

To Close The Report 

• Click on the “Close” 
button 

  

 
The new label report will be displayed in the Report tab in the Database window. 
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CONVERTING A DATABASE 

You can open an Access 2 or an Access 97 database in Access 2000.  But the 
database will open in read-only mode.  This means you can view the data, but you 
can’t create any new tables, queries, forms or reports, or modify any existing ones.  To 
do that you will need to convert your database to Access 2000. 

If the database is simple, ie it does not contain lots of clever features using Access 
Basic programming, it should convert easily.  If in doubt, contact the IT Helpdesk or 
the person who originally created the database. 

To Convert A Database To Access 2000 

• Open Access 2000, but do not open a database 

• In the “Tools” menu, select “Database Utilities”, then “Convert Database”, 
then “To Current Access Database Version” 

The Database to Convert From 
dialog box will appear. 

• Navigate through the 
folder structure and 
select the database you 
wish to convert 

• Click on the “Convert” 
button 

  

An identical looking dialog box 
will appear.  This one is used to 
save a copy of the converted 
database. 

In the Convert Database Into 
dialog box. 

• Enter a name for the 
converted database and 
select a folder to save it in

• Click on the “Save” button
 

 

A new copy of the database will be created that is Access 2000 compatible.  The 
original database will still exist in the old format. 

 
You should then open the converted database in Access 2000 and check to see that it 
functions properly and contains all the correct data. 

Do not delete the old database until you are certain there are no problems with the 
new one. 


